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1. Menggunakan Domain Unsurya Untuk Mengakses Akun Google

Verifikasi akun sebagai langkah awal menggunakan email domain unsurya di google
Untuk masuk ke Akun Google (atau produk Google):

1. Kunjungi laman masuk produk (myaccount.google.com untuk Akun Google) >
Masukan email dengan domain @unsurya.ac.id - Next - Masukan password yang
sudah diberikan > Next

Google Google

Signin Welcome

to continue to Gmail @ puskom@unsurya.ac.id ¥

Email or phone

i Ent d
puskom@unsurya.ac.id Nter your p:
........ | [©)
Forgot email?
Naot your computer? Use Guest mode to sign in privately. Forgot password?
Learn more
Create account

2. Langkah berikutnya dengan verifikasi nomor hp - Get Code - Cek ada di pesan
masuk = masukan code yang terkirim pada pesan masuk di hp Anda - Verify

Google
Google ¢

Welcome to your new account

Verify your identity

compatible with many Google

Enter verification code
e ———————

T

3. Masukan password baru untuk menggantikan password default yang sebelumnya -

Selesai
Google

Create a new, strong password that you
don't use for other websites.

Create password

Confim password

Change password

A3
¢
® ¢
N \\M )
Welcome
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2.

Menggunakan Google Meet Sebagai Host

1. Masuk ke akun google dengan email domain @unsurya.ac.id

2.

3.

4.

Pilih ikon thumnails di pojok kanan atas - Pilih icon Google Meet

C & mailgoogle.com/mail/u/0/finbox ® @pmgn

™M Gmail (B il - & & o

a- ¢
l— Compose
No new mail!
Inbox Account Drive
W Starred
- R |
© Snoozed Account Created Learn how to use E
10% Gmail
= sent Docs Sheets
B Dafts Set a signature e Change profile image
Setup progress

oo ®

Calendar Chat
Using 0 GB Pregram Policies
Powered by Google
Google+ Sites Contacts

Na recent chats

Setelah diarahkan ke jendela Google Meet - Klik Join or Start a Meeting (maka akan
muncul jendela input > Masukan nama/judul meeting/matakuliah dIl - Continue

- (8] X
™M Inbox - puskom@unsurya. X Q@ Meet x + M Inbex - puskom@unsurya.: X @ Meet X e i3
C @ meetgoogle.com/?pli=1&authuser=0 g & Paused ) : C @ meetgoogle.com/?pli=1&authuser=0 b :

\ _—

&M« Sat, Apr Join or start a meeting

Enter the meeting code or nickname. To start your own meeting,

+  Join or start a meeting enter a nickname or leave blank,

Nothing scheduled today

Setelah klik tombol continue - muncul area webcamp - Join Now

puskom@unsurya.ac.id
Q Meet Switch account

Matakuliah Pemograman webj

matakuliahpemogramanweb

No one else is here

@ (3] Present

Other options

2 Join and use a phone for audio
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5. Copy joining info > kemudian pastekan link tersebut ke grup mahasiwa atau user
agar invite kedalam ruang meeting

o Details @ Attachments (0)

matakuliahpemogramanweb

Meeting nickname (Can only be used within Universitas Suryadarma)

Joining info

https://meet.google.com/zon-zjcd-ycy
Dial-in: (US) +1 786-558-2818 PIN: 996 509 489#

(] Copy joining info

6. Jika ingin menampilkan materi kepada user > Pilih Present - Pilih Aplication

Window > Pilih salah satu materi yang akan ditampilkan kepada user/mahasiswa >
Share

Share your screen

Chrome wants to share the contents of your screen with meet.google.com. Choose what you'd like to share.

Your Entire Screen Application Window 1

matakuliahpemogramanweb

No one else i

Join now

Other options

er

e -
Klik
Present

%2 Join and use a phone for audio

7. Setelah pilih tombol share, maka materi akan tampil di semua user/mahasiswa, dan

untuk stop sharing tinggal klik tombol stop sharing, sehingga kembali ke tampilan
interaktif visual.

[#) Modul Pemrograman Web dengan PHP ... X

Tipe Data
Pada PHP, tipe data variabel tidak didefinisikan oleh programmer, akan tetapl
secara otomatis ditentukan oleh Intepreter PHP. Namun demikian, PHP
mendukung 8 (delapan) buah tipe data primitif, yaitu :

lean

1. bo«

2. int

3.

4.

5.

6.

7.

8.

Pre

Nama File tipe.php
Deskripsi  : Program contoh penanganan beberapa tipe data dasar dalam

PHP.

P
= "0411500400";
$nama = 'chotimatul Musyarofah®;

S St untuk berhenti sharing

ec]
rint " ._Sumur; print "<br;
rintf ( 'X.3f<br>", Snila
2 13883
4| e1se || meetgoogie.comis 9 dov Stop sharing
k s e nEmmoo
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3. Menjadwalkan Kegiatan Video Meeting / Teleconference

1. Masuk ke akun google dengan email domain @unsurya.ac.id
2. Pilih ikon thumnails di pojok kanan atas = Pilih icon Calendar

. @

Account

M &

Gmail Drive

20 -
=]
Docs Sheets Slides
Calendar Chat Meet
Google+ Sites Contacts

3. Setelah ke aplikasi kalender - Tentukan tanggal dan waktu yang akan dijadwalkan dengan
cara klik pada tanggal yang dituju, misalnya tanggal 6 Mei 2020 - dari jam 09.00 — 11.30
dan tuliskan nama acaranya misalnya “Rapat Koordinasi”

= Calendar Today ¢ > May 2020 Q @ &8 Dpay
WED 3 . R x
Create 6 Rapat Koordinasi
-
May 2020 < > S Event Outofoffice Reminder Task Appointment slots
ST oW gof s
% w = 2 1 2 o @  May6,2020 {5:00am - [EEREE My 6,2020
° v o s 2,  Addguests
w m |2®14 - = ¢ 4 oatam (15t
Towow o w2 o oam Add Gaogle Meet vid
' e O0slE MEELIEEO 1 anam (2 hrs)
w s ow oW om om oW
M @  Addlocation
L 11:30am (2.5 hrs)
\ = Add description
) oam
Meet with... 12:00pm (3 hrs)
8 @ puskominfo ~

12:30pm (3.5 hrs)

My calendars A uoreoptions (||

puskominfo

4. Pilih icon Google Meet Video Conferencing = sehingga muncul kode join meet - Save

X
Rapat Koordinasi

Event Out of office Reminder Task Appointment slots

@ May 6,2020 9:00am - 11:30am May 6, 2020

2. Add guests

Join with Google Meet
meet.google.com/gai-gjpo-rva
Up to 250 participants @

@ Add location

= Add description

3 @ npuskominfo v

More opt'on
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meeting, Selesali

4. Menambahkan Add Ons Google Meet Grid View

4.1 Menambahkan di Browser Microsoft Edge

1. Pilih menu di pojok kanan atas—> Eksetensions = search

5. Bagikan/copy link dari Google Meet yang sudah dibuat ke user yang akan diajak untuk

B Microsoft Edge Add-ons »* - 8
O O https//microsoftedge.microseft.com/addons/search/grid?hl =en-US e B &@
N Culi T
B Microsoft | Edge Add-ons®™
Cien
e window Ctrl 4 Shifti N
Searchiresilis Showing 13 results for “grid” — wow +
Q\ﬁrnq\ﬁ Meet Grid View ) |
@& e 3 cul

Filter by categary

2
Accessibility Bootstrap 4 Haraj Ul Enhanced B Collections
Responsive Helper o
Developer taals ) & 5 Culep
*kdkxk (2) o .
Entertainment [ share

Productivity g = : n > Findonpage Cul+k

2. Kililk Icon Google Meet Grid View > Get > Selesai

Google Meet Grid Wiew - Micro: X | 4=
O & nhttps//microsoftedge.microsoft.com/addons/detail/ogbbehbkemdciebilbkpjgopohnpfolj7hl=en-Us ] k3

B Microsoft | Edge Add-ons ™™ AllM

Home / Accessibility / Google Meet Grid View

Google Meet Grid View
Fugi Tech

Accessibility | % % % % % 2]

4.2 Manambahkan di Browser Firefox

1. Pilih menu tools - Add-ons - cari dengan keyword “Google Meet Grid
View”

Bookmarks Jeols Help

2 Add-ons Manager x ‘Add-o

Sign In 10 Firefox..

< ¢ o Web Developer > | w
&/ Kementerian BUMN iV Login <P Page Info Cirl+l  5iLain Dah... (i Metoda Latihan Test K.. mo Boruto (Episode 153) .. @D Log In < Seruput Kopi .. @ Active Submis
Qptions e
Find more enensions( 0ogle Meet Grid Vies ) o J
+ . q
K> Recommendations Manage Your Extensions ]
*. Extensions Enabled
. .
2 results found for "Google Meet Grid View"
Filter results Search results
Sort by Google Meet Grid View 1,950 users
o o Adds a togele to use a grid layout in Gaogle Meets
e oo o ot Chris Gamble
Add-on Type
All v
- JA Jira Assistant 1,576 users
Operating System Help to track & upload work done on a Jira Ticket on timely basis and generate
Al ~ report. Notify about latest updates in Jira Issues, shortage in worklogs and meetings

based on integration with Calendar.

e 9 o & Shridhar TL

) Recommended add-ons enly
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3. Pilih Add Firefox

Firefox Browser
. AD D—ONS Explore Extensions Themes More.. v

Google Meet Grid View
by Chris Gamble

Adds a toggle to use a grid layout in Google Meets

‘ + Add to Firefox '

e

A This is not monitored for security through Mozilla's Recommended Extensions program. Make sure you trust it before
installing.

Learn more

4.3 Menambahkan di Browser Chrome
1. Pilih menu dipojok kanan atas - More Tools - Extensions

Cirl+ T
Ctrl=N

indow  Ctrl+Shift=N

Cirl+p
Ctrl+F
»
. di opy Pt
ing data Settings
Q. search Google or type a URL Hele
Task manager Shift+Esc
Exit
Develaper ool Cul+Shift+1
~ +

Web Store Add shortcut

2. Search dengan Google Meet Grid View - Pilih Icon - Add to Crome

Google Meet Grid View

—
ﬁ Offered by: Chris Gamble ‘ Jrr—— ’
o rome
Adds a toggle to use a grid layout in Google Meets N—

Yk ok k iyt ¢ Accessibility

5. Mengubah Tampilan Google Meet

1. Untuk mengubah tampilan atau layout agar terlihat semua peserta meeting dengan
cara pilih menu di pojok kanan bawah - Change layout - Pilih Tiled
Catatan: Browser yang digunakan harus versi terbaru (admin menggunakan

MURYAN AWALUDIN, S.KOM., M.KOM.



@ PUSKOMINFO UNSURYA

mricrosoft edge yang terbaru), untuk browser lain, jika masih versi lama harus
ditambahkan add ons MultiGrid / Google Meet Grid View

: = B @ -

<~ © A nhttps//meet.google.com/cyc-vwju-xo:

Change layout x
on
= = .0,
4. Auto

. |
€83 settings
%2 use aphone for audio Sidebar Spotlight
[D  Reportaproblem
@ hep

2. Sehingga tampilan seperti pada gambar
I Apps M Gmai @ YouTube BY Maps @ TabBau M Inbox (47) - hari

H) You are presenting

6. Menampilkan Presentasi/Data di Google Meet

1. Pilih Present Now = Window -> Pilih File/Data yang akan bagikan - Share

) hitpsiffmeet gaogle.com/cye-vuu-x A A hitlpsd/meel google cam

Msting detalls ~ RPN @

2. Setelah pilih share maka file atau data akan tampil di semua peserta
3. Untuk berhenti share file/data = Pilih tombol Stop Sharing

MURYAN AWALUDIN, S.KOM., M.KOM.
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e = Dayout -

Ll gy . € Reset Slide Show ¥ x
Paste Naw = Resume Slide Show [V
- ¥ Slide - = Section ~

Clipboard = Slides

1
*

It° 4. Penulisan limiah dan
Publikasi Penelitian

Muryan Awaludin, § Kem., M.Kom.

Course Outline

1. Pengantar Penelitian

2. Tahapar Penelitian
3. Literature Review
( “. Penlisan limish dan Publikasi Penalitian

5. Systemati Lerature Review (SLR] |

' 6. Pembimbingan dan Presentasi Penslitian |

A A \'_\ Yulelm] [ I— £ Find
AL L3 0OM N 8- Replace
G A ) A e I+ Select -
Paragraph Drawing Editing

4 13 20 1 o 1 20000003 4

|| Course Outline

1. Pengantar Penelitian |

2. Tahapan Penelitian |

3. Literature Review |

5. Systematic Literature Review (SLR) |

6. Pembimbingan dan Presentasi Penelitian |

meet.google.com is sharing a wmdow.@ﬂid:

7. Membuat Kelas di Google Classroom

1. Masuk ke akun google dengan email domain @unsurya.ac.id
2. Pilih ikon thumbnails di pojok kanan atas = Pilih icon Classroom

MM Inbox - puskomBunsuraacid - X+

« C & mailgoogle.com/mail/u/0/ifinbox

= M Gmail

| compose

O inbox
*  Starred
]

Snaczed

Search mail -

@
Setup progress.

Fhotos Hangouts
| ]
No new maill
Forms Keep Jambeard
Learn how to use & ‘
Account Creste
Cloud Seg. Earth Collections

Change profile image

lassron: Cloud Print

More from G Suite Marketplace

3. Setelah klik icon Classroom = Jendela Classroom = Continue = Pilih Im a Teacher

Google Classroom

Classroom helps classes communicate, save time, and stay organized.
Learn more

@ puskominfo

By joining, you agree to share contact informatios

@ puskem@unsurya acid

&

with people in your class. Leam mare

Pick your role

I'M A STUDENT

4. Klikicon + = Create Class = Isikan kolom sesuai kelas = Create

MURYAN AWALUDIN, S.KOM., M.KOM. n
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g

M Inbox - puskom@unsurya: X Y Classes x  +
€ > C @ classroomgooglecom/h
= Google Classroom

Join class

Create O 3!

.

Don't see your existing classes?

TRY ANOTHER ACCOUNT

Create class

Class name (required)
Pemograman Web

Section
Program Studi Sistem Informasi

Subject
Reguler Pagi

Room
Lab. Komputer Unsurya

Cancel
y

5. Jika sudah dibuat - dibagian header ada kode kelas = copy and share kode tersebut kepada

Class code 74w3hfi { ] ]

Invite students to your class X

Add students on the People page or give them the

class code to join

Contoh Kelas yang sudah dibuat:

mahasiswa/siswa, agar bisa masuk dan mengikuti kegiatan kelas

MURYAN AWALUDIN, S.KOM., M.KOM. n
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K Kelas X + B = S

- C @& cdassroomgoogle.com/u/0.. Lo &5 Q ¢ %’ :

o

Google Classroom + i

[=) Uuntuk diperiksa D Kalender

Pemrograman Web 2 ... Metode Penelitian

MI D-lll PLLUA - Kamis - 10:30-12:30 - Sistem Informasi S.1 - Jumat - 18:00-...

Multimedia Animasi M) Pemrograman Web 1...

Sistemn Informasi 5.1 | Sabtu - 16:00°7 ... | SHMI | Selasa - 08:00-10:00

—

8. Membuat Menu Kelas di Google Classroom

= Pemrograman Web 1(HTML dan CSS) Forum Tugas Kelas Anggota Nilai [ &
SHMI| Selasa - 08:00-10:00
[™ Google Kalender (&) Folder Drive Kelas
Semua topik s 5
SENSI
MATERI Absensi Kehadiran Diedlt 09,39
ues
UTS dan UAS MATERI

@ Membuat Layout BOX di rightbar
® Membuat Top Right dan Banner dengan HT.

@ Membuat Menu Web dengan CSS dan HTML

(@) werbuat Header wen =5

MURYAN AWALUDIN, S.KOM., M.KOM.
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Pembuatan menu kelas ini sangat diperlukan, agar mahasiswa/siswa mudah memahami isi atau petunjuk
di kelas tersebut seperti menu absensi, materi, tugas, uts dan uas. Langkah membuat menu setiap
kategori sebagai berikut:

1. Buka kelas yang akan dibuatkan menu, misalnya: Kelas Pemograman Web (HTML dan CSS),
Pilih menu tugas kelas - Pilih tombol Buat - Topik

B Tugas Kelas untuk Pemrogramar X +

< C @& classroom.google.com/u/0/w/MTQOMjc2Mzc INTQx/t/all 1

= Pemrograman Web 1 (HTML dan CSS) Forum Tugas Kelas Anggota N
SI-MI| Selasa - 08:00-10:00
N—
’ D Fooaet

Semua topik @
Tugas

ABSENSI .

El Tugas kuis
MATERI

Pertanyaan
TUGAS

M Materi

UTS dan UAS - i i
= Gunakan kembali postingan

@ Membuat Top Right dan Banner dengan HT...

@ Membuat Menu Web dengan €SS dan HTML

2. Setelah pilih menu Topik, maka muncul jendela “Tambahkan Topik”, isikan Topik misalnya
pertama isi dengan ABSENSI - Klik tambahkan

Tambahkan topik

Topik
ABSENSI-NEW

Batal Tambahkan

3. Untuk membuat Kategori menu yang lain misalnya MATERI, TUGAS, UTS DAN UAS, cara
pembuatannya sama dengan Langkah ke2, sehingga hasil penambahan kategori seperti gambar
dibawah

Semua topik

ABSENSI

MATERI

TUGAS

UTS dan UAS

MURYAN AWALUDIN, S.KOM., M.KOM.
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9. Membuat Isi Menu Absensi Kelas di Google Classroom

Setelah membuat kategori menu, sekarang membuat untuk isi dari masing-masing menu, misalnya
menu kelas diisi dengan form google, materi bisa diisi dengan beberapa format seperti .docx, .pdf, link
url, dan sebagainya.

1. Untuk membuat menu absensi pilih menu Tugas Kelas - Buat - Tugas = sehingga muncul

jendala Tugas
L dan CSS) Foram

-+ Buat

E] Tugas kuis

Pertanyaan

[ Materi
-
—

Gunakan kembali postingan

B Topik par

2. Isikan Judul dan Deskripsi = Buat = Formulir

X Tugas

B Jud
SENSI MAHASISWA/SISWA

1

@ Tambahkan 2

B Dokumen

Slide

Spreadsheet
b

@ = >

3. Setelah klik menu formulir maka muncul jendela formulir = berikan nama judul formulir dan
tambahkan data-data formulir

MURYAN AWALUDIN, S.KOM., M.KOM.
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Absensi Mahasiswa/Siswa

Batas absensi 30 menit setelah jam kuliah/pelajaran dimulai

Teks jawaban singkat

INIM/NIS (& =

4

Jawaban singkat

Tool box GForm

Nama *

Teks jawaban singkat

NEBFHe

4. Jika sudah selesai membuatkan form absensi (auto save), kemudian kembali ke menu tugas >
Pilih pilihan Topi ABSENSI (Pada sidebar sebelah kanan) - KIlik Tugaskan

B Tugas Kelas untuk Pemrogramar X +

< C @ classroom.google.com/u/0/w/MTQOMjc2MzcTNTQx/t/all
X Tugas
B Judul

ABSENSI MAHASISWA/SISWA

Petunjuk (opsicnal)
1. Klik form --> isikan sesuai format yang ada

2. Jika sudah selsai isi > Kirim

@ Tambahkan + Buat

Formulir tanpa judul
Google Formulir

10. Membuat Isi Menu Materi Kelas di Google Classroom

MURYAN AWALUDIN, S.KOM., M.KOM.
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Pemrograma.. +

Poin

100 v

Tenggat

Tidak ada batas waktu

Rubrik

+ Rubrik

-

X

a % &

Semua siswa
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1. Untuk membuat menu materi pilih menu Tugas Kelas - Buat - Materi - sehingga

3.

muncul jendala materi

B Tugas Kelas untuk Pemrogramar X —+

<« C @ classroom.google.com/u/0/w/MTQOMjc2Mzc1NTQx/t/all
= Pemrograman Web 1 (HTML dan CSS) Forum ugas Kelas Anggota Nilai
SI-MI | Selasa - 08:00-10:00
__ SNa—

( 4+ Buat ) [¥) Google Kalender (&) Folder

S topik
emua topi. @ Tugas
ABSENSI
E| Tugas kuis

MATER! Diposting tanggal

Pertanyaan

o
Diedit

UTS dan UAS - . .
e Gunakan kembali postingan

B Topik

Setelah muncul jendela Materi > Isikan judul materi dan deskripsi = Jika ingin upload
bantuk materi yang sudah ada pilih Tambahkan (file dari google drive, link (url), file (dari
device, dan link yang sudah diupload di Youtube), pilih Buat jika inign membuat dokumen
di GSE (Dokumen, Slide, Spreradsheet, Gambar, Formulir)

— Pemrograman Web 1 (HTML dan CSS)
= SIMI|Selasa - 08:00-10:00

Forum

( 4+ Buat )
Semua topik B Tugs
AEsEnS Bl Tugas kuis
MATERI

Pertanyaan

TUGAS
0 Tambahkan + Buat + Buat

UTS dan UAS

=5 Gunakan kembali postingan @  Google Drive B Dokumen
@  Link Slide
B Topik W File Spreadsheet
N O YouTube E Gambar
@ Membuat Layout BOX di rightbar E Formulir

rF

Jika sudah semua, pilih Topik “Materi” dan klik Posting (jika langsung di tampilkan pada
mahasiswa/siswa) atau Jadwalkan (untuk menjadwalkan materi yang telah dibuat

BY Tugas Kelas untuk Pemragramar X + - [N A
<« G @ classroomgoogle com/u/0mMTQDMic2MzcINTQx/all a % @ :
m 70 Untuk

Semua siswa v

e Membuat Menu dengan HTML dan CSS
Video YouTube 28 menit

MURYAN AWALUDIN, S.KOM., M.KOM.
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11. Mengkonversi File CSV ke EXCEL

File konversi ini didapat dari file pada google form, misalnya: file Absensi yang dibuat di Google
Form (Gf):

1. KIlik link Gf = sehingga diarahkan ke form

= Pemrograman Web 1 (HTML dan CSS) Forum ansgota Nilal
SI-MI| Selasa - D8:00-10:00

e
+ Buat [ Google Kalender (&) Folder Drive Kelas

Semus topik @
ABSENS|
R @ Absens Kehadiran Diedit 09 59

TUGAS Ticak ada batas wakiu

Absensi kehadiran dianggap hadir, jika manasiswa/siswa hadir 30 menit sebelum dan

TS dan Uas ‘sesudah jam yang matakuliah/mata pelajaran 2 19
‘‘‘‘‘
— ,
Absensi Matakuliah HTML
Google Fermulir
Lihat pertanyaan
2. Setelah berada dihalaman Gf Absensi = Edit Formulir

Tugas Kelas untuk Pemrogramar X [ Absensi Matakulioh HTML dan ¢ X - ] >
s/d/e/1FAIpQLSFrhxwfC42ITx5IMTizoOylqjSMHUQOorIZoYsKWWMK-JhPCQ/viewform Y @ i

Absensi Matakuliah HTML dan CSS

Selasa, | 08.00-10.00

* Wajib

Alamat email *

Email Anda

3. Kilik menu Respons > menu 3 titik sebelah kanan > Download tanggapan (.csv)

= > C ] dn(sgmoglemm,f‘mmc,’dﬂnGmrAGrr\prqE-VrBEEIZUGanapG?LnMrpQIQHEFRE&.’Pdnﬁ‘reﬂpnns.ﬂ‘
e o = K
1
Pevtanyaan
2
47 tanggapan

Menerima tanggapan (]

E Absensi Matakulish HTML [ <%

Dapatkan notifikasi email untuk respons baru

Filih tujuan tanggapan
Ringkasan Pertanyaan Individual

. . 3
Siapa yang telah menanggapi? &, Download tanggapan (.csv)

% Cetak semua tanggapan
Email &

arsalan.pratama8@gmail.com E Hapus semua tanggapan
dwirezal44@gmail.com

mannnalancachamamail cam

MURYAN AWALUDIN, S.KOM., M.KOM.
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4. Setelah file di unduh = Ekstrak file = muncul file .csv

Extract GFORM

e View Compressed Folder Tools

This PC » Local Disk (C}) » Users » DELL » Downloads » GFORM

ey
Name Date modified Type
’ Absensi Matakuliah HTM . 2/3/2021 11:15 PM Microsoft Excel Com...
R Matakuliah H RAR ZIP archive
n

¢ B opw with WinRAR
4 § Extracfiles...
'
¢ % Extract to Absensi Matakuliah HTML.csv~ 14

7-Zip >

CRC SHA >

g Edit with Notepad ++
Fm_ .

5. Buka file .csv = blok/sorot kolom pertama = Pilih menu Data > Text to Columns

Absensi Matakuliah HTML - Ex Muryan Awaludin e ? [=3]

Insert  Page Formulas ew  View Help

F [P From Text/csV [ Recent Sources *, Tl Queries & Connections . e s, [777] Y & 3 3 |7 *H
. [ From Web [ Existing Connections o "—’h L L s o . i ot F G
et res Stocks  Geography = | Z| Sort ilter fext to t-If Forecast = Outlir
Data - [111From Table/Range Al - M| A W advanced Ncolumny/=F - B Analysis -+ Sheet o
Get & Transform Data Queries & Connections Data Types Sart & Filter Data Tools Forecast
AL - fo Capwaktu
A B c D E F G H J K L M N o P Q R

1 |cap waktNama penNIM Nama Len Program Studi

2 |2020/09/C|arsalan.pr 1.81E+08 Arsalan PrS1 Sistem Informasi

3 |2020/09/C|dwireza14 1.81E+08 Mohamm. D3 Manajemen Informatika
4 |2020/09/C|manggala; 1.81E+08 Diyan Mul$1 Sistem Informasi

5 |2020/09/(/fadelrand| 1.81E+08 fadel randS1 Sistem Informasi

6 |2020/09/C|jasudinne: 1.81E+08 Jasudin  $1 Sistem Informasi

7 |2020/09/C|ahmadekc 1.81E+08 Ahmad Ek D3 Manajemen Informatika
8 |2020/09/C|feliaalkaff 1.81E+08 Felia FebriD3 Manajemen Informatika
9 |2020/09/¢ wicaksh@ 1.81E+08 Happy Dia D3 Manajemen Informatika
10 |2020/09/C|hangrezaf 1.81E+08 REZA FAHIS1 Sistem Informasi

11 |2020/09/( wira0712¢ 1.81E+08 Kauko WirS1 Sistem Informasi

12 |2020/09/(pujid440@ 1.81E+08 Pujiati Les 51 Sistem Informasi

13 |2020/09/C/rahmanar 1.81E+08 Arif rahm: D3 Manajemen Informatika
14 |12020/08/¢|prilafortur 1.81E+08 Prila FortuS1 Sistem Informasi

15 |2020/09/C|prilafortur 1.81E+08 Prila FortuS1 Sistem Informasi

16 |2020/09/(|salsabilan 1.81E+08 nindira auS1 Sistem Informasi

17 |2020/08/(|ibrahimiry 17057008 Irwan Ibrz 51 Sistem Informasi

18 |2020/08/(|jasudinne; 1.81E+08 Jasudin 51 Sistem Informasi

19 |2020/09/(|sonangsur 1.81E+08 sonang su 51 Sistem Informasi

20 |2020/09/(|rachmatsz 17073002 Rachmat £D3 Manajemen Informatika

6. Setelah dipilih Text to Columns = muncul jendela Convert to Columns Wizard - Delimited
- Next - kemudian check list Tab, Semicolon, Comma = Next

The Text Wizard has determined that your data is Delimited. | This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview below.
I this is correet, choose Next, or choose the data type that best describes your data, e
Original data type ]

chg file type that best describes your data:

ited - Characters such as commas or tabs separate each field,

[7] Treat consecutive delimiters as one

() Fixed width - Fields are aligned in columns with spaces between each field. e qllumnecy - v
Preview of selected data:

'ap waktu ~

020/0%/08 10: AM GMT+7 10:33:13 AM GMT+7

020/03/08 10:33:14 AM GMT+7 | 3 10:33:14 AM GMTH7

020/08/08 10: AM GMT+T7 10 15 AM GMT+7

020/09/08 10: AM GMT+T | 10 18 AM GMT+7

020/09/08 10: AM GMT+7 020/09/08 10 25 AM GMT+7

020/0%/08 10: AM GMT+7 b4 L} 020/09/08 10:34:20 AM GMT+7 ~
I
| ‘

Cancel < Back Einish | Cancel < Back N N> > Einish
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7. Kemudian Pilih General = Finish

Convert Taxt 1o Columns Wizard - Step 3 of 3

i scrmen ks s selet ech cobum and s the Data Format From TeCSV L Recene Sources
From Wets Feasig Convactions. | | &
= Kelrein G
: from Tab/Range A.
Lo ‘General converts numeric vakues t rumbers,date valuss 10 dates, and al o - oeay
Tt erining vabies o 13t
. ais s
Do | MoY - Advancd.
Dopotimwort ol G493 1 Cap wakty Nama pengguna NI Nama Lengkap
2 2020/09/08 103313 AM tarsalan. Lom 181051009
Destination: | $A$1 £ 3 2020/09/08 103314 AM 1dwircza144@gmail.com 181041006 Mohammad Dwi Rezs
4 2020/09/08 103315 AM tmanggslagrazha@gmail.com 181051002 Diyan Mukti Raharjo
5 2020/09/08 10-3318 AM tadelrandhika 14 @gma.com 181051001 fadie randhika ol sasha
6 2020/09/08 103325 AM tjasudinnezay@gmad com 181051016 lasugia

Data prediew
2020/09/08 10-3¢:20 AM 1ahmadeko200ggmail.com

2020/09/08 10:34:22 AM ttelaalkaftghgmall.com
2020/09/08 10.34:22 AM fwicaksh@gmail.com

2020/09/08 10:34:27 AM thangrezatahievi@gmail.com
020/09/08 10:34:29 AM twiraQ71298@grmait.com
2020/09/08 10:34:30 AM 1 pujidd40@ gmait.com

2020/09/08 10.35:26 AM 1 rahmanari2599@gmad com
2020/09/08 103510 AM tpriafortunsdewi0R04@gmail.com
2020/09/06 103619 AM t pedafortunadewiCB0d Bgmait com
020/09/08 10:39-12 AM tsaisabianindira@gmail com
2020/09/08 10-40:03 AM 1 brahimirwan%0@gmall com

16 2020/09/08 10:43:49 AM tjasudinaezap@gmai.com

181041007 Ahmad £ko Saputro
181041003 Fella Febrizky
181041005 Happy Dian Wicaksona
121031018 REZA FAHLEV)
181051006 Kauko Wir
181051008 Pujati Lestari
181041008 Acif rahman hakim
181051011 Prils Fortuna Dewi
181051011 Prila Fortuna Dewi
181051007 nindira auria saisabila

17057008 truean brahim
181031016 Jasudin

8. Pilih File > Save As - Pilih format Excel Workbook = Save

u Save As

T « Users » DELL » Downloads » GFORM v
Organize ~ New folder
~ ~
= This PC Name

~# 3D Objects
[ Desktop

[ Documents

Absensi Matakuliah HTML

¥ Downloads
h Music

&= Pictures

m Videos

% Local Disk (C)
- DATA (D)
CD Drive (E)

¥ Network v <

D3 Mansjemen Informatika
S1 Sistem informasi
S1 Sistem informasi
S1 Sistemn nformasi
03 Manajemen informatika
03 Manajemen Informatia
03 Manajemen Informatika
53 Sistem informasi

informasi

$3 Sistem nformasi

3] £ Search GFORM

Date modified

2/4/2021 2:31 PM

Type

Microsoft Exce

ame: | Absensi Matakuliah Hm\

Excel Workbook

Authors:  PUSKOMINFO Tags: Add atag

[ Save Thumbnail

~ Hide Folders

MURYAN AWALUDIN, S.KOM., M.KOM.

Cancel

17



